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Technical Support
Safety and Regulatory Notices
This product is not to be used in any environment where radio frequency equipment is prohibited 
or restricted in its use. To ensure that your modem is deactivated you should remove it from your 
computer under the above conditions.

Regulatory Notices
Federal Communications Commission Radio Frequency Interference Statement

This equipment has been certified to comply within the limits of a class B digital device pursuant 
to part 15 and 24 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in residential situations. This equipment generates, uses, and can 
radiate radio frequency energy, and, if not properly installed and used in accordance with the 
instructions, may cause harmful interference to radio or television reception, which can be 
determined by turning the equipment on and off. You are encouraged to try to correct the 
interference by one or more of the following measures:

Reorient or relocate the receiving antenna of the television, radio or cordless telephone.

• Increase the separation between the equipment and the receiver.

• Connect the equipment to an outlet on a circuit different from that to which the receiver is 
connected.

• Consult the dealer or an experienced radio/television technician for additional suggestions.

Technical Support
If you have any questions or comments about your FB200C, please contact the Novatel Wireless 
Inc. Customer Support team.

WWW: http://www.novatelwireless.com/support/index.html

Email: support@novatelwireless.com

Phone: 1 (888) 888-9231

System Requirements
The following items are required to set up and use your FB200C modem:

• Pentium 90 processor or higher.

• Windows 2000 or XP

• 64MB RAM

• 16MB hard drive space.
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• CD-ROM drive.

• the Wireless Connection Manager software, included with your FB200C modem, and

• a user account, including a User Name and Password, from a network carrier with PCS CDMA 
1X service.

To purchase a user account, please contact network carrier. For a list of network service provider 
please email Novatel Wireless at support@novatelwireless.com or call 1 (888) 888-9231.
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FB200C Overview and 
Installation
This section provides an overview of the modem box and installation instructions. 

FB200C front panel
The FB200C front panel has power, service, and data status indicators and a reset button as 
shown on Figure 1.

Figure 1 FB200C Front Panel

Indicator/Button Function

Reset Reset button for the FB200C.

Power The power LED indicates power is on when lit.

Service The service LED indicates that the FB200C has acquired 
network service.

Data The data LED indicates data activity between the 
FB200C and the host computer.
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FB200C Rear Panel
The rear panel of the FB200C is where the power, communication port, and antenna cables are 
connected. This is shown in Figure 2.

Figure 2 FB200C Rear Panel

Connector Description

12V DC Power cable plugs into this connector. The input supply 
should be between 10 to 18 Volts DC.

Serial RS232 connector for modem main port. When using this 
port, the modem acts as a AT modem. The Serial port is 
disconnected when an active USB port is connected. 

USB USB modem port. When using the USB port, the host 
computer will have additional modem status information 
not available when using the serial connector. USB must 
be used when using Windows Connection Manager.

Antenna TNC antennae connector for external mount antennae.
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Connecting the power cable
The FB200C comes supplied with a power cable as illustrated in Figure 3.

Figure 3 Power cable

Wire Color Functionality

Green This wire is the positive terminal for the modem. The 
modem is designed to be always on when power is 
applied. Connect the green wire to vehicle IGN (IGNI-
TION) if you only want the modem on when vehicle is on. 
Connect the green wire to an always on fuse protected cir-
cuit connection to have modem always on.

Black Ground
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Installing the Wireless 
Connection Manager Software on 
Windows
This section guides you step-by-step through the Wireless Connection Manager for Windows 
installation procedure. 

Once you have completed the set up and installation process, you will be able to use your 
FB200C Modem with your Internet applications.

Warning: This application is only supported by Windows 2000 and XP

To install the Wireless Connection Manager onto your laptop or notebook computer:

1. Insert the Installation CD into the CD-ROM drive of your desktop computer. Run the 
installation program WirelessConnectionManagerVx.xx.xx.exe.

2. Follow the instructions displayed on screen to begin installing the Wireless Connection 
Manager software. The Welcome window will appear, shown in Figure 1.

Figure 1 Welcome Window
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3. Read the information displayed on screen and click Next to continue. The Novatel Wireless 
License Agreement will appear.

4. Read the agreement and select I read and agree to the above terms. 

5. Click Next to continue. The Start Copying Files window will appear, shown in Figure 2.

Figure 2 Start Copying Files Window
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6. If you would like to review or change an installation setting, click Back. If you are satisfied 
with the installation settings click Next to continue. The Installation Complete window will 
appear, shown in Figure 3.

Figure 3 Installation Complete Window

7. Click Finish to exit the Installation program. The Install window will appear, shown in Figure 
4.

Figure 4 Install Window

8. Click OK to restart your computer.

9. Once your computer has rebooted, make sure the modem is powered on by checking to 
make sure the Power indicator is ON. Connect the FB200C’s USB cable into the computer’s 
USB port. Windows will automatically detect and install the necessary modem drivers in 
order to operate the FB200C modem. 

10. When Windows has finished installing the FB200C modem drivers, you can access the 
Wireless Connection Manager by double-clicking on the shortcut icon that has been placed 
on your computer’s desktop.



14   

Manual Revision A for Windows

Uninstalling the Wireless Connection Manager 
Software
To uninstall the Wireless Connection Manager application, select Start -> Programs -> Novatel 
Wireless -> Wireless Connection Manager -> Wireless Connection Manager Uninstall. The 
Uninstall wizard will open, and guide you through removing the Wireless Connection Manager 
program from your computer or by using the Windows Control panel and selecting "Add or 
Remove Programs".
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Getting Started With the Wireless 
Connection Manager
The Wireless Connection Manager application allows you to monitor and control the operation of 
your FB200C modem. 

This section explains the basic steps required to operate the Wireless Connection Manager for 
Windows.

Connecting to the Network
In order to use your Internet applications, your modem must first establish a network connection.

To connect to the network:

1. Launch the Wireless Connection Manager application by double-clicking the Wireless 
Connection Manager icon, located on your desktop.

2. From the Wireless Connection Manager Main window, click Connect. See Figure 1.

Figure 1 Wireless Connection Manager Main Window
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3. If this is the first time you have attempted to connect to the network, the Wireless 
Connection Manager will walk you through the 5 step activation process. See Figure 2.

Figure 2 Welcome Message

   

4. Click Next. The Activation Information window will appear, as shown in Figure 3. 

Figure 3 Activation Information Window
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5. Click Next. When the enterprise administrator provides you with the activation code, enter 
the number as indicated in Figure 4.

Figure 4 Activation code window

6. Click Next. Enter the phone number and MSID given by the Customer Solutions Advocate 
as shown in Figure 5.

Figure 5 MDN and MSID window
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7. Click Next. The FB200C modem is activated properly when you see the successful 
activation window as shown in Figure 6. Click Finish to close activation window. 

Figure 6 successful activation window

8. The modem's network connection status will be displayed in the Modem status bar, 
highlighted in Figure 7.

Figure 7 Modem Status Bar

If the modem is unable to connect to the network, check the modem’s signal strength as displayed 
in the Signal Strength status bar. The greater the number of green bars present, the stronger 
the signal strength. If the signal strength is poor, try changing your location in order to pick up a 
stronger signal.
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Disconnecting From the Network
To disconnect your modem from the network, click Disconnect from the Wireless Connection 
Manager Main window, shown in Figure 8.

Figure 8 Disconnect Button

To disconnect from the network and close the Wireless Connection Manager application, click the 
 located in the top-right corner of the Wireless Connection Manager Main window.

Alternately, you can select Exit from the Modem menu.

Quitting the Wireless Connection Manager 
Application
To quit the Wireless Connection Manager application, click the  located in the top-right corner 
of the Wireless Connection Manager main window.

Alternately, you can select Exit from the File menu, shown in Figure 9.

Figure 9 Exit Command
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The modem will terminate its network connection, and the Wireless Connection Manager 
application will shut down.

System Tray Icons
When you launch the Wireless Connection Manager application, a system tray icon will appear 
in the bottom-right corner of your desktop. These tray icons provide easy access to the Wireless 
Connection Manager Main window and the modem’s connection status.

The following icons indicate the modem’s connection status:

 - If this icon is visible, the modem is currently connected to the network.

 - If this icon is visible, the modem is not connected to the network.

If the Wireless Connection Manager window is not visible, double-click the tray icon to open it.

Alternately, you can control the operation of the Wireless Connection Manager by right-clicking 
the tray icon and selecting an action from the pop-up menu.
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Getting to Know the Wireless 
Connection Manager for 
Windows
This section introduces the various windows and menu commands that are contained in the 
Wireless Connection Manager application for Windows.

The Wireless Connection Manager Main Window
When you launch the Wireless Connection Manager application for Windows, the Main window 
will open, shown in Figure 1.

Figure 1 Wireless Connection Manager Main Window

The Wireless Connection Manager main window consists of the following items:

Duration Field This field indicates how long the modem has been con-
nected to the network.

Bytes Sent Field This field indicates the amount of data (bytes) the 
modem has sent during the current network session.

Bytes Received Field This field indicates the amount of data (bytes) the 
modem has received during the current network ses-
sion.

Signal Strength Sta-
tus Bar

This status bar indicates the modem’s signal strength. If 
adequate signal strength is present, a number of the five 
bars will be shaded green. 

Modem Status Bar This status bar displays the modem’s network connec-
tion status.
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The Modem Configuration Window
To access the Modem Configuration window, shown in Figure 2, select Configuration from the 
Modem menu.

Figure 2 Modem Configuration Window

The following fields are displayed in the Modem Configuration window:

Network Service Field This value directs the modem to attempt to connect only 
with your service provide’s network. This is a read-only 
field and cannot be altered.

Receive Next Call As 
Field

Data Only - This value directs the modem to receive the 
next call as packet data only. This is a read-only field 
and cannot be altered.

Current System Time 
Field

This field displays the current system time as displayed 
on your computer’s desktop.

Current CDMA Time 
Field

This field displays the time as indicated by the CDMA 
base station. 

Show Connection 
Properties While Con-
necting Check Box

Select this check box if you wish to see the Connection 
Properties window the next time you attempt to connect 
to the network.
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The Modem Properties Window
To access the Modem Properties window, select Properties from the Modem menu

.

Figure 3 Modem Properties Window

The information contained in this window is useful for Customer Support in diagnosing problems 
you may experience while using your modem.
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The following fields are contained in the Modem Properties window:

User Name This field displays your network user name.

Mobile Identification 
Number

This field displays your modem’s Mobile Identification 
Number. This number is used by the CDMA base station 
to identify your modem.

ESN (HEX) This field displays your modem’s Electronic Serial Num-
ber (ESN). The ESN is a unique number given to each 
modem as a means of identification.

PRL Version This field displays your modem’s Preferred Roaming List 
(PRL) version. The PRL is a list of networks your modem 
would prefer to connect with.

Firmware Version This field displays the firmware version your modem 
uses.

Hardware Version This field displays the hardware version your modem 
uses.

Modem Type This field displays the type of modem core your modem 
uses.

Manufacturer This field displays the name of the firmware manufactur-
ing company.
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The Detailed Status Report Window
To access the Detailed Status Report window, select Detailed Status Report from the Tools 
menu.

The Detailed Status Report window contains two tabs; the General and History tabs.

Figure 4 General Tab

The General tab, shown in Figure 4, is displayed by default and contains the following items:

Modem Status Bar This status bar displays the modem’s network connec-
tion status.

Total Bytes Trans-
ferred Field

This field displays the total number of bytes, both sent 
and received, during the current network session.

Bytes Sent Field This field displays the total number of bytes sent, during 
the current network session.

Bytes Received Field This field displays the total number of bytes received 
during the current network session.

Date Byte Totals Were 
Last Cleared Field

This field displays the date the byte totals were last 
cleared.
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The History tab, shown in Figure 5, displays the date, time, and current modem and network 
session activities. This tab is useful when attempting to diagnose problems with either your 
modem or network connection.

Figure 5 History Tab

The About Wireless Connection Manager Window
To access the About Wireless Connection Manager window, shown in Figure 6, select About 
Wireless Connection Manager from the Help menu.

Figure 6 About Wireless Connection Manager Window

This window contains information about the Wireless Connection Manager application, including:

• The software version

• The date the software was released

• The copyright information
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Additional Menu Commands
The following menu commands are also available from the Wireless Connection Manager 
application. 

Clear Bytes Command

To clear the modem’s total bytes counted, select Clear Bytes from the Tools menu.

All byte totals counted, either sent or received, by the modem during the current network session 
will be cleared. 

The modem’s byte totals are displayed in the General tab of the Detailed Status Report window, 
shown in Figure 7.

Figure 7 Total Bytes Counter

Always on Top Command

To keep the Wireless Connection Manager window on top of all other windows, select Always 
on Top from the Window menu, as shown in Figure 8.

Figure 8 Always on Top Command
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Note: Click Always on Top a second time to disable this command. 

Hide Window Command

To hide the Wireless Connection Manager window, select Hide Window from the Window 
menu, as shown in Figure 9.

 

Figure 9 Hide Window Command

The Wireless Connection Manager window will be minimized to the system tray icon .

Double-click on the icon to re-open the Wireless Connection Manager window.

Wireless Connection Manager Help

To access the online help for the Wireless Connection Manager application, select Wireless 
Connection Manager Help from the Help menu, as shown in Figure 10. The application will 
launch the Wireless Connection Manager online help files.

Figure 10 Wireless Connection Manager Help Command
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Troubleshooting 
This section provides solutions to problems you may encounter while using your FB200C Modem 
on a Windows operating system. 

You can contact Novatel Wireless representative at support@novatelwireless.com or 1 (888) 
888-9231 for additional information.

Troubleshooting a Connection Failure
If you are unable to establish a network connection, the following suggestions may correct the 
problem:

• Verify that your FB200C modem is powered on and communication port is connected to 
the computer.

• If the Wireless Connection Manager cannot communicate with the modem, exit the 
Wireless Connection Manager application.  Reset your FB200C Modem by using a thin 
pen tip to push the reset button. This resets the modem hardware.

• Check your modem’s signal strength (displayed on the Wireless Connection Manager 
Main window). If the signal strength is weak (less than two bars), your modem might be 
unable to establish a network connection. Try moving to another location in order to pick 
up a stronger signal.

• Launch the Wireless Connection Manager application and try to connect to the network 
again.
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Error Messages
One of the following messages may be displayed if your modem is unable to register or connect 
with the Mobile Network.

Message Solution

Modem Not 
Responding

This message may appear if you plug your FB200C modem into the USB 
port and click on the Wireless Connection Manager shortcut icon before 
your computer has detected the modem. Click OK on the message 
window and wait between 15-30 seconds before clicking the shortcut 
icon. If the message appears a second time, unplug and reconnect the 
USB port to the modem and wait until your computer detects the modem 
before clicking the Wireless Connection Manager shortcut icon again.

No Service If this message is displayed, there is no service available at this time. 
The network could be busy or undergoing maintenance. Try connecting 
to the network at a later time or moving to another location if you are 
outside the network’s coverage area.

Modem is not 
present

If this message is displayed, verify that the modem USB cable is 
plugged in properly. Note: Modem detection is only available when the 
modem is connected using the USB port.

Modem is already in 
use

This message indicates the modem port is busy. Verify whether your 
modem has already established a network connection. If the modem is 
not currently connected to the network, exit the Wireless Connection 
Manager program, relaunch the application and try a second time to 
connect to the network.

Device firmware 
incompatible

If this message appears, your FB200C modem’s firmware is 
incompatible with your current version of the Wireless Connection 
Manager software. Please contact Novatel Wireless customer support 
in order to upgrade your modem’s firmware.

There was no 
answer

If this message appears, try and connect at a later time. If the message 
appears again, contact your service provider customer support.

The remote access 
server is not 
responding

If this message appears, try and connect at a later time or move to a 
better signal strength location. If you still cannot connect to the network, 
contact your service provider customer support.

The modem has 
reported an error

If this message is displayed, reboot your computer and try to connect 
again. If you are still unable to connect, contact your service provider 
customer support.
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Frequently Asked Questions

Question Answer

How can I check the 
quality of my 
connection?

The Signal Strength status bar, located on the Wireless Connection 
Manager Main window, indicates the quality of the modem’s signal. If 
two or more bars are shaded green, the modem’s signal strength is 
good. If less than two bars are shaded green, the signal strength is poor 
and it will be difficult to establish and maintain a network connection.

How do I find out 
what version of the 
Wireless 
Connection 
Manager software 
I’m using?

Open the Wireless Connection Manager Main window and select About 
Wireless Connection Manager from the Help menu. The Wireless 
Connection Manager software version, release date, and copyright 
information will be displayed in the About Wireless Connection 
Manager window.

How do I find out 
what version of 
firmware and 
hardware my 
modem is using?

Open the Wireless Connection Manager Main window and select 
Properties from the Modem menu. The modem’s firmware and 
hardware version, as well as the modem type and manufacturer, will be 
displayed in the Modem Properties window.

I have forgotten my 
User Name and 
Password. What do I 
do?

Call your network service provider customer support.

How can I tell if I 
have service?

The Wireless Connection Manager indicates whether you have service. 
The Wireless Connection Manager will indicate if there is no service 
available in the Modem Status field.

What is an ESN? An ESN (electronic serial number) is a unique number that identifies 
your wireless modem to the network. You can check your modem’s ESN 
by selecting Properties from the Modem menu.

Why won’t the 
Wireless 
Connection 
Manager recognize 
my User Name or 
Password?

Verify that you are entering the correct information in the Connection 
Properties window. If the Caps Lock feature is activated, turn it off and 
enter the information again. If the problem persists, call Customer 
Support of the network service provider to verify you have the correct 
User Name and Password.
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